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TÓPICOS DO MÓDULO 
 

 

 
FigurA 1: ModulO: Tópicos de Competências Digitais  
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SÍMBOLOS CHAVE 
 

 

 

Símbolos Descrição 

 Definição de termos 

 

 

Dicas 

 
Planos de aula/Documentos de Apoio 
Ex. Tópico 1 – Actividade 1  

 
Ligado a ‘Competências Empreendedoras’   
Ex. Competências de Comunicação, 
Competências de apresentação, etc.  
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DESCRIÇÃO DO MÓDULO 
 

 

 

O módulo 'Competências Digitais' fornece informações sobre as principais 

características e aplicações do 'Google', tais como Pesquisa Google, Google e-mail 

(Gmail), Google Drive, Google Calendário e Contactos Google. Os adultos 

aprenderão como fazê-lo: 

1. Pesquisa de informação online 

2. Criar uma conta de e-mail e como utilizá-la  

3. Informação da loja online 

4. Criar calendários e eventos  

5. Criar contactos ou grupo de contactos 
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TÓPICO 1 PESQUISA DE INFORMAÇÃO ONLINE (PESQUISA NO 

GOOGLE): VISÃO GERAL  
 

 

 

O principal objectivo deste tópico é fornecer toda a informação necessária sobre a 

Internet com termos básicos e os navegadores web mais populares. Além disso, está 

incluído um guia passo-a-passo para introduzir como pesquisar informação online 

usando o navegador web 'Google Chrome', como pesquisar diferentes tipos de 

conteúdo, como usar a pesquisa avançada e quais são as principais estratégias e 

técnicas de pesquisa. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ligado a ‘Competências Empreendedoras’   

- Habilidades Organizacionais: São as capacidades que lhe permitem manter-se concentrado 

em diferentes tarefas, e utilizar o seu tempo de forma eficaz e eficiente a fim de alcançar o 

resultado esperado. 

                 - Aptidões de resolução de problemas: Ajudam-no a determinar a origem de um problema e a 

encontrar uma solução eficaz.
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1.1. Definição  

 

Definição: 

 A pesquisa online é o processo de pesquisa e recuperação interactiva de dados 

solicitados através da Internet (Hawkins, Donald, Brown & Carolyn, 1980).  

Actualmente, a pesquisa em linha é uma das mais importantes "competências 

digitais". Permite aos utilizadores encontrar rapidamente o que procuram e 

explorar uma variedade de fontes de informação. 

 

 

Google Search, ou simplesmente Google, é um motor de busca web 

desenvolvido pela Google LLC. É o motor de busca mais utilizado na World Wide 

Web em todas as plataformas, 

 

 

 

 

 

 

 

 

 

 

- Pode aceder à Pesquisa Google a partir de um browser (Google Chrome, etc.) utilizando o seu 

computador de secretária, aplicação móvel (iOS e Android) 

 

Plano de Aula/Actividades:  

- Plano de Aula 1  
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1.2. Características da Pesquisa Google  
 

De acordo com as estatísticas de 2020, a Google Search votou como o motor de busca mais popular nos 

Estados Unidos em 2019 - a Google detém 94% da quota de mercado. 

As vantagens da pesquisa de informação online:   

1) Poupe tempo: Os utilizadores podem pesquisar informação em qualquer lugar e em qualquer 

altura de forma rápida e fácil, em vez de utilizarem jornais, livros, revistas, etc.  

2) Acessibilidade a nível mundial: Os utilizadores podem aceder à informação em qualquer parte do 

mundo e a qualquer hora 

3) Acesso livre: A maioria dos sítios Web é de livre utilização e os utilizadores podem utilizá-los a 

qualquer momento como quiserem  

4) Variedade: Uma variedade de fontes de informação de enciclopédias em linha, estudos 

universitários, fóruns, blogs, etc. 

 

 

 

 

 

 

 

 

 

 

Plano de Aula/Actividade:  

- Plano de Aula 2 
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1.3.  Termos básicos relaciodados com a internet  
 

Uma compreensão dos termos básicos é útil: 

1) Internet: 

A Internet é a rede de comunicação mais significativa de computadores e dispositivos electrónicos do 

mundo. A Internet tem muitas aplicações, tais como correio electrónico (e-mail), transferência de 

ficheiros, conversação online, e a aplicação mais utilizada de toda a World Wide Web (www).  

1) Pesquisa em linha: 

A pesquisa online é um método de pesquisa que envolve uma recolha de informação da Internet. 

2) WWW: 

A World Wide Web ou "WWW" ou a "Web" como também é chamada, é a aplicação da Internet que 

contém websites e páginas web que podem ser acedidas por um URL digitado num navegador web. 

3) Navegador da Web: 

Web browser é um software como o Google Chrome, Mozilla Firefox e Internet Explorer que permite a 

um computador aceder e exibir documentos, imagens, som ou vídeos da World Wide Web. 

4) URL/Domínio: 

Um domínio, ou nome de domínio, é o endereço (ou URL) que as pessoas utilizam para visitar websites 

na Internet. Aparece na barra de endereços do navegador da web. Por exemplo, 

www.emphasyscentre.com 

5) Domínio Top-Level (TLD): 

Um domínio de nível superior identifica algo que está relacionado com o website, como o seu objectivo, 

o proprietário, ou a origem geográfica 

 

 

 

 

 

Figura 1: URL (Medium, 2018)  
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Plano de Aula/Actividades:  

- Plano de Aula 2  
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1.4. Navegadores we comuns     
 

Um navegador (por vezes referido como um navegador) é uma aplicação de software utilizada para aceder 

a informação na World Wide Web. Um URL que é o endereço de cada página web, imagem, e vídeo 

permite aos navegadores recebê-los e apresentá-los num ecrã de computador, smartphone e tablet. (Para 

efeitos deste módulo, centrar-nos-emos no navegador web 'Google Chrome'). 

 

1. Microsoft Edge  

 

2. Google Chrome  

 

3. Mozilla Firefox  

 

4. Apple Safari  

  

 

5. Opera   

 

 

 

Figura 2: Navegadores Web mais populares (Startcounter, n.d.)  

O Google Chrome é um dos navegadores web mais populares da web. De acordo com estatísticas do 

Statcounter, em Janeiro de 2019, o Chrome atingiu 70% da quota de mercado global dos navegadores 

de secretária. As principais características do Google Chrome são:   

1. Navegador de alta velocidade 

2. Seguro e protegido  

3. Fácil de usar com um design de fácil utilização 

4. Gestão de Separadores: Arrastar as abas para fora em janelas separadas 

5. Sincronização entre dispositivos 

6. Integração com Google Apps 

7. Navegação privada (Incognito) 
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Dica:  

- Os dois navegadores web mais populares são o Google Chrome e o Apple Safari. 

  

 

 Plano de Aula/Actividades 

- Plano de Aula 3 
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1.5.  Domínios padrão de nível superior  
 

Os domínios mais populares são: 

 

1) .com - Negócios comerciais 

2) .edu - Instituições de ensino 

3) .gov - Agências governamentais 

4) .mil - Militares 

5) .net - Organização de redes 

6) .org - Organizações (sem fins lucrativos) 

7) Domínios de topo de código de país: 

a. .ca - Canadá  

b. .uk - Reino Unido  

c. .cy - Chipre  

d. .pt - Portugal  

e. .lv - Letónia  

f. .bg - Bulgária 
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1.6.  Instalar o Google Chrome (no Windows)  

 

PASSO 1: Abra o seu navegador web 

PASSO 2: Pesquisa por 'Google Chrome 

PASSO 3: Clica em ‘https://www.google.com/chrome/ ‘  

 

Figura 3: Google Chrome homepage  

PASSO 4: Clica em ‘Download Chrome’ 

 

Figura 4: Google Chrome homepage  

 

https://www.google.com/chrome/


P a g e  | 13 

 

 
This project has been funded with support from the European Commission. This communication reflects the 

views only of the author, and the Commission cannot be held responsible for any use which may be made of 

the information contained therein. Submission number: 2019-1-LV01-KA204-060337 

PASSO 5: O ficheiro de instalação é descarregado para o seu computador de secretária 

 

 

Figure 5: Download Google Chrome  

 

PASSO 6: Clique no ficheiro de instalação para executar a aplicação   

PASSO 7: Siga as instruções para descarregar com sucesso o 'Google Chrome' para o seu computador de 

secretária 
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Figura 6: Download Google Chrome  
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1.7.  Introdução ao Google Chrome 
 

Como iniciar a procura:  

PASSO 1: Localize o ícone do Browser (Google Chrome) no ambiente de trabalho. 

 

Figura 7: Ambiente de Trabalho do Computador  

 

PASSO 2: Clique duas vezes no ícone para abrir o browser. Irá abrir uma janela referente ao browser. 

  

 

 

 

 

 

 

 

 

Figura 8: Página inicial do Browser. 
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Para aceder a um sítio web é necessário conhecer o "URL" - mais comummente referido como um 

endereço web. O "URL - endereço web" é como um endereço de uma casa. Se der um endereço de casa 

a alguém, ele pode navegar para encontrar a casa. 

PASSO 3: Clique na barra de endereços 

PASSO 4: Digite o URL (endereço da página web), clique em 'Enter' e o website será carregado. 

 

Figura 9: Escrever um endereço URL na barra de endereços 

 

OU 

 

PASSO 5: Clique na barra de endereços e digite o URL www.google.com  

NOTA:  

- Há muitos motores de busca disponíveis para além do que o Google está a oferecer. Mas é comummente 

aceite, que actualmente é o mais poderoso entre todos os outros. 

- O Google chrome fornece uma ligação directa ao motor de busca Google, pelo que não há necessidade 

de navegar para o site do motor de busca Google, pode apenas digitar as palavras-chave que procura na 

barra de endereços. 

PASSO 6: Na área da caixa de pesquisa digite as palavras-chave para a informação que deseja pesquisar 

 

 

 

 

 

http://www.google.com/
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Figura 10: Pesquisa Google 

 

PASSO 7: Aparecerá uma lista de resultados, e pode clicar numa das ligações para aceder à página web. 

 

 

 

 

 

 

 

 

Figura 11: Pesquisa de resultados 

 

Estratégias básicas de pesquisa: 

1. Mantenha-o simples: Usar palavras-chave  

2. Anúncios Google: Os primeiros resultados na primeira página de resultados de pesquisa são 

geralmente Anúncios Google em que os anunciantes pagam através da plataforma de anúncios Google 

para gerar anúncios para os seus produtos/serviços. Os utilizadores podem reconhecer os anúncios do 

Google através do ícone 'Anúncios'.  

 

 

Results 
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Figura 12: Anúncios do Google  

 

1. Considerar sugestões: Os motores de busca irão sugerir os resultados mais populares, por isso é 

importante que os utilizadores possam seleccionar uma das sugestões 

2. Usar linguagem simples: Não usar palavras ou frases complicadas para obter resultados.   
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Moreover, there are some search techniques that are used to help users to use keywords for their online 

searching information, such as the use of Boolean Operators between the words: 

1. Boolean Operators (Connector Words): 

 

Boolean Operators (Connector Words) 

A/A Name: Description: 
1. AND The AND operator searches for 

information for ALL search terms given. 
Use the connector ‘AND’ when searching 
for both terms. For example: 
 
digital AND entrepreneurship 
 

2. OR  The OR operator searches for information 
for one or several search terms given. 
Usually, the connector ‘OR’ is used to 
combine synonyms. For example: 
 
entrepreneurship OR entrepreneur 
 
 
 
 

3. NOT  The NOT operator excludes information. 
Usually, the connector ‘NOT’ is used to 
find items that have one word and do not 
have the other word. For example, to 
search for guns but not hunting:  
 
cakes NOT chocolate 
  

 

 Lesson Plans/Activities:  

- Lesson Plan 4 
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2. Advanced Search  

 

Definition: 

Advanced search is a built-in feature of Google (and most web engines) that allows a user to 

specify additional requirements while searching information. Figure 8 illustrates the advanced search 

features. A user can search information for a specific topic, language, region, words, file format etc.  

 

Figure 13: Advanced search  

 

How to use Advanced search: 

STEP 1: Click on the search box area and type in the keywords for the information you wish to search 

 



P a g e  | 21 

 

 
This project has been funded with support from the European Commission. This communication reflects the 

views only of the author, and the Commission cannot be held responsible for any use which may be made of 

the information contained therein. Submission number: 2019-1-LV01-KA204-060337 

 

 

 

 

 

 

 

 

 

Figure 14: Google Search 

STEP 2: Click on ‘Settings’ 

STEP3: Click on ‘Advanced search’ 

 

Figure 15: Google Search 

  

1 

2 
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STEP 4: Fill in the fields   

 

Figure 16: Advanced Search  

 

How to search images, videos etc.:  

STEP 1: Click on the search box area and type in the keywords for the information you wish to search  

 

 

 

 

 

 

 

 

 

 

Figure 17: Google Search  
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STEP 2: Click on the ‘Images’ tab to search for images, videos etc.  

  

Figure 18: Google Search  

 

 

Figure 19: Google Search – Images, Videos etc.  
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STEP 3: Click on the ‘More’ tab to search for books, flights etc.   

Figure 20: Google Search – Books, flights etc.  

 Lesson Plans/Activities:  

- Lesson Plan 5 

 

How to access the browser history: 

 

Definition: 

The browser history is the list of websites a user has visited—it includes information such as 

page title and time of visit — for a certain period of time. 

STEP 1: Click on the three dots Icon on the top right corner.  

STEP 2: Click on ‘History’ 

STEP 3: Click on ‘History’ 
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Figure 21: Browser history 

 

STEP 4: Here you can see the list of websites you already visited  

STEP 5: Click on the desired website from the History List 

 

Figure 22: The Browser History Screen 

 Lesson Plans/Activities:  

- Lesson Plan 6 

 

  

1 

2 3 

4 
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How to clear browsing history: 

STEP 1: Click on the three dots Icon at the top right corner.  

STEP 2: Click on ‘History’ 

STEP 3: Click on ‘History’ 

 

Figure 23: Browser history 

 

STEP 4: Here you can see the list of websites you already visited  

STEP 5: Click on ‘Clear browsing data’   

 

 

 

 

 

 

 

 

 

 

Figure 24: Clear browsing history 

 

STEP 1 

STEP 2 STEP 3 

STEP 5 
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STEP 6: You can select the ‘Time range’ to clear the browsing data  

STEP 7: Click on ‘Clear data’ 

 

 

Figure 25: Clear browsing history 

 

  

STEP 6 

STEP 7 
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TÓPICO 2 E-MAIL DO GOOGLE- GMAIL: VISÃO  
 

 

 

The main goal of this topic is to present adults how to create and use an e-mail 

account. Adults will understand the main terms of e-mail such as user ID, domain 

name etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Linked to ‘Entrepreneurial Competences’   

- Organisational Skills: Are the abilities that allows you to stay focused on different tasks, and  

use your time effectively and efficiently in order to accomplish the expected result. 

- Time Management: Is the process of organizing and planning daily tasks   

 

- You can access the Gmail from a desktop computer, mobile application (iOS and Android)  
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2.1. Definição 
 

Definition: 

Gmail is a free email service developed by Google. To access Gmail you need to connect with your 

Google account. A Google email account is an account that ends with @gmail.com for example 

chrystalla_emphasyscentre@gmail.com  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

mailto:chrystalla_emphasyscentre@gmail.com
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2.2. Características do Email do Google 
 

The benefits of Google Email:   

1) Storage space: Google Email offers a huge storage space 

2) Online access anywhere 

3) Synchronisation with Android: Android users can automatically sync their Android account with 

their Google account 

4) Easy search through emails  

5) Organisation of emails: Users can create folders to keep their emails organised  

 

 

 

 

 

 

 

 

 

 

 

 

 

Lesson Plans/Activities:  

- Lesson Plan 7  
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2.3.  Termos básicos relacionados com o e-mail 
 

An understanding of basic terms is helpful: 

1) E-mail:  

An email is a method which can be used from a person to send information from 

a computer to another, using the Internet. That information can have different 

forms such as text, image, audio, and video. Emails are ideal for international 

communication with no delay, no cost and no limited recipients.  

2) Google e-mail (Gmail): 

Gmail is a free web-based e-mail provider from Google and has become the market leader in free e-mail 

services with more than a billion users worldwide (Williams, 2020).  

3) User ID / Username: 

Username is a unique identification (two accounts cannot have the same username) of a person on a 

particular server. 

4) Domain name / Host name: 

Domain is the location at which the email is sent. This refers to the mail server (which is the computer) 

where the recipient has a mailbox. For example, @gmail.com, @yahoo.com, @outlook.com  

5) Spam e-mail:  

Spam email is an unwanted email and it can include malicious links. Often, spam e-mail is sent for 

commercial purposes such as advertisements, newsletters etc.  

 

 

 

 

 

 

 

Figure 26: E-mail structure  

 

Lesson Plans/Activities:  

- Lesson Plan 8  

Username Domain name 

fine2workproject@gmail.com 
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Tips:  

- For professional e-mail accounts: Avoid to use nicknames, numbers for the user ID/username and 

use your name for example chrystalla@emphasyscentre.com or 

chrystallathrasyvoulou@emphasyscentre.com (Chrystalla or ChrystallaThrasyvoulou = User 

ID/Username & emphasyscentre= Domain name/Host name)   

- To identify and recognize the junk e-mails: Unknown sender, misspellings for example z0om with a 

zero, promoting urgent discounts for example ‘Flash Sale – Everything 20% off’, contains attachments 

and virus warning. 

 

 

 

 

 

  

mailto:chrystalla@emphasyscentre.com
mailto:chrystallathrasyvoulou@emphasyscentre.com
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2.4. Criar uma conta de e-mail   
 

How to create an e-mail account (Gmail):  

STEP 1: Navigate to https://www.gmail.com 

STEP 2: Click on the ‘Create an account’ button 

 

Figure 27: Gmail Webpage  

STEP 3: Then fill in the required fields. 

You are required to: 

a. Enter your Name and Surname. 

b. Enter a Username which will be unique in Gmail.  

c. Enter a password. The key aspects of a strong password are length (at least 8 characters), a mix 

of letters (upper and lower case), numbers, and symbols 

STEP 4: Click on the “Next” button. 

 

Figure 28: Filling in the Account Information 

STEP 2 

a 

b 

c 

STEP 4 

FINE2WORKPROJECT 

c 

https://www.gmail.com/
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STEP 5: You will be directed to the Personal Information page, where you will be required to enter some 

personal information. 

a. Your Mobile phone number. This is optional information but it will add an extra safety feature in 

case you get locked out from your account or have forgotten your password. 

b. An additional email address. This is also optional but it will also add an extra safety net for your 

account. 

c. Your date of Birth. 

d. Your gender. 

STEP 6: Click on the “Next” button 

 

Figure 29: Filling in the Personal Information 

STEP 7: To use the free services of Google you will need to accept the privacy terms and conditions by 

checking the two checkboxes. 

STEP 8: Click on the “Create Account” button 

a 

b 

c 

d  

STEP 6 

FINE2WORKPROJECT 



P a g e  | 35 

 

 
This project has been funded with support from the European Commission. This communication reflects the 

views only of the author, and the Commission cannot be held responsible for any use which may be made of 

the information contained therein. Submission number: 2019-1-LV01-KA204-060337 

 

Figure 30: Privacy and Terms Page 

STEP 9: The welcome Screen of Gmail appears. Click on the “Next” button 

 

Figure 31: The Welcome Screen of Gmail 

STEP 10: There are three different View Styles currently available in Gmail. For the purposes of this 

course we will choose the Default View. Click on the ‘Ok’ button 

STEP 8 

STEP 7 
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Figure 32: The “Choose View Style” Page 

STEP 11: You can now view your Gmail Account page 

 

Figure 33: The Interface of your Gmail account 

 

Lesson Plans/Activities:  

- Lesson Plan 9 
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2.5. Navegar no Gmail  
 

How to use search box:  

STEP 1:  Click on the ‘Search box’  

 

Figure 34: Search box 
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How to change settings:  

STEP 1:  Click on ‘Settings’  

 

 

 

 

 

 

 

 

 

 

Figure 35: Settings 

STEP 2: You can now view the ‘Quick Settings’  

 

 

 

 

 

 

 

 

 

 

Density 

Theme 

Inbox type 
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Figure 36: Quick Settings 

STEP 3: Click ‘See all settings’ to view and change all the settings   

 

 

 

 

 

 

 

 

 

 

Figure 37: All settings  

 

Reading pane 
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STEP 4: Change settings    

 

Figure 38: All settings  

 

How to change theme:  

STEP 1: Click on ‘Settings’ 

STEP 2: Click on ‘View all’ next to the ‘Theme’ 

 

Figure 39: Settings 

 

1 

2 
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STEP 3: Pick your theme  

STEP 4: Click on the ‘Save’ button 

 

Figure 40: Pick your theme 

 

STEP 5: You can change the text background, vignette and blur of the theme. 

 

Figure 41: Edit your theme 
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NOTE: 

Users can edit the theme: 

- Text background: Light or Dark (see figure 42) 

- Vignette: Make corners darker (see figure 42) 

- Blur: Blur background image (see figure 42) 

 

Figure 42: Edit your theme 

How to use support button:  

STEP 1: Click on the ‘Support’ button 
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Figure 43: Support button 

NOTE:  

- Type anything you want to search in to the ‘Search box’  
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How to view folders:  

STEP 1: Click on the ‘Inbox’ folder  

STEP 2: Click on the ‘Sent’ folder  

STEP 3: Click on the ‘Drafts’ folder  

STEP 4: Click on the ‘Spam’ folder  

STEP 5: Click on the ‘Trash’ folder  

 

 

Figure 44: Folders  
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NOTE:  

1. Inbox folder: Is the main folder that your received mails gets stored in  

2. Sent folder: Is the folder that stores mails that were successfully sent to recipients  

3. Draft folder: Is the folder that stores mails that were not successfully sent to recipients or you 

have not yet completed the email  

4. Spam folder: Is the folder that stores the spam emails that you may receive from unwanted email 

addresses such as ads  

5. Trash folder: Is the folder that stores deleted mails and keeps the mails for 30 days   

 

 

Lesson Plans/Activities:  

- Lesson Plan 10 
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2.6. Introdução ao e-mail (Gmail) 
 

How to compose an e-mail 

STEP 1: Click on the ‘Compose’ button  

STEP 2: Click on the full screen button in order to have a better and clearer view when composing an 

email. 

Figure 45: Compose an e-mail  

 

 

 

 

 

 

 

 

 

Figure 46: Maximize  
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STEP 3: There are certain fields which have to be filled in for the email to be properly sent. These are: 

a. To: The primary recipients of the email 

b. Cc: Short for Carbon Copy, this is for secondary recipients i.e. the persons whom you decide 

to keep them informed. 

c. Bcc: Short for Blind Carbon Copy, email addresses typed in this field are not visible to other 

recipients.  

d. Subject: The title of our email or a short meaningful description of the text in the email 

e. E-mail content: Compose the e-mail content  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 47: Maximize  
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How to send an e-mail 

STEP 1: After you have written your message, click on the ‘Send’ button in order to send your email. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 48: Send e-mail  

 

Lesson Plans/Activities:  

- Lesson Plan 11 
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How to reply/reply all to an e-mail 

STEP 1: Click on the e-mail received  

Figure 49: Inbox – New e-mail   
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STEP 2: Click on the ‘Reply Button’  

Figure 50: Reply button 

 

STEP 3: Compose the reply text and click on the ‘Send’ button  

 

Figure 51: Reply 
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NOTE: 

Reply: Reply to a single person that sent you the mail, so none of the primary recipients or CC recipients 

will receive your reply  

 

STEP 3: Click on the ‘Reply all Button’  

 

Figure 52: Reply all  
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NOTE: 

- Reply all: Reply to everyone on the thread  

 

Tips:  

- Gmail offers a ‘Smart Reply’ system and you can reply to an email with some 

suggested responses such as Thank you (Figure 42)  

 

 

How to forward an e-mail 

STEP 1: Click on the e-mail received  

Figure 53: Inbox – New e-mail   
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STEP 2: Click on the ‘Forward’ button  

 

Figure 54: Inbox – New e-mail 

STEP 3: Type in the e-mail address of the receiver  

STEP 4: Compose the text  

STEP 5: Click on the ‘Send’ button  

 

Figure 55: Forward an e-mail 

 

 

Lesson Plans/Activities:  

- Lesson Plan 12 

5 

4 

3 
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How to delete an e-mail 

STEP 1: Locate the email to be deleted. Click on the ‘Bin’ Button and the email will be sent to the Recycle 

Bin. 

 

Figure 56: Delete an e-mail  

NOTE: 

- This does not delete the email completely 

STEP 2: In order to delete the email permanently, navigate to the trash area by clicking on the “More” 

option and then click on “Trash” folder 

STEP 3: Select the desired email by clicking on the checkbox next to the email 

STEP 4: Click on the ‘Delete forever’ option. 

Figure 57: Delete an e-mail from the ‘Trash folder’ 
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How to add favourites ‘Starred’ e-mails 

STEP 1: Locate the email to be deleted. Click on the ‘Star icon’ 

STEP 2: Click on the ‘Starred’ folder to find all the favorites e-mails  

 

Figure 58: Starred e-mails  

STEP 3: Click on the ‘Starred’ folder to view all the favorites e-mails  

Figure 59: Starred folder  
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How to create labels  

 

Tips:  

- Gmail label helps the user to keep their e-mails organized. For example, if the user is a 

teacher, he/she could create labels for each class ‘1st class’, ‘2nd class’ etc. 

 

STEP 1: Click on the ‘Create a new label’ 

Figure 60: Create a new label   

STEP 2: Type the name of the label  

STEP 3: Click on the ‘Create’ button   

 

 

 

 

 

 

 

 

Figure 61: Create a new label   
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STEP 4: Click on the ‘1st class’ category to view the emails which have this label  

 

Figure 62: New label   

Lesson Plans/Activities:  

- Lesson Plan 13 

 

How to edit/remove a label:  

STEP 1: Click on the ‘More’ button  

STEP 2: Click on ‘Manage labels’ 

 

 

 

1 
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Figure 63: Manage labels     

 

STEP 3: You can change the settings of the label – Hide from the label list, remove or edit 

 

Figure 64: Edit/Remove labels     
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How to move e-mails into labels 

STEP 1: Click on ‘Inbox’  

STEP 2: Right click from your mouse on the desired e-mail you want to move into a label  

STEP 3: Click on the ‘Move to’ button 

STEP 4: Select the label  

Figure 65: Move e-mails into labels  

 

How to mark an e-mail as unread: 

STEP 1: Click on the ‘Inbox’ button 

STEP 2: Right click from your mouse on the desired e-mail you want to mark as unread   

STEP 3: Click on the ‘Mark as unread’   

  

 

Lesson Plans/Activities:  

- Lesson Plan 13 
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Figure 66: Mark us unread  

 

How to snooze of an e-mail 

 

Tips:  

- Snooze an e-mail: The email will be temporarily removed from the inbox and it will return 

back on the top of the inbox at the time you set it 

 

 

STEP 1: Click on ‘Inbox’  

STEP 2: Right click from your mouse to the desired e-mail you prefer to snooze   

STEP 3: Click on ‘Snooze’    
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Figure 67: Snooze of an e-mail   

How to print an e-mail: 

STEP 1: Click on ‘Inbox’  

STEP 2: Open an e-mail 

STEP 3: Click on ‘Print’  

Figure 68: Print an e-mail    
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STEP 4: Select your printer  

STEP 5: Click on ‘Print’ 

Figure 69: Print an e-mail    

How to block a contact  

STEP 1: Click on ‘Inbox’  

STEP 2: Open an e-mail 

STEP 3: Click on the three dots on the right-hand side 

STEP 4: Click on the ‘Block (the name of the sender)’ option 

 

Figure 70: Βlock a contact  
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How to send a file as an attachment in an email 

Apart from simple text messages, email messages can contain image files, sound files, video 

clip files, compressed files etc. These files are known as attached files or simply as attachments. 

Attached files are files are sent together with e-mail messages. 

STEP 1: Click on the ‘Compose’ button to create a new email 

STEP 2: Click on the ‘Attach a file’ button 

 

 

 

 

 

 

 

 

 

 

Figure 71: Send an attachment  

STEP 3: Navigate to the folder with the file needed to be attached  

  

Figure 72: Locating the attachment  

1 
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STEP 4: Select the file you wish to attach  

STEP 5: Click on the ‘Open’ button 

 

Figure 73: Add an attachment in an e-mail  

 

STEP 6: The file will be seen as an attachment at the bottom part of the e-mail  

 

Figure 74: Add an attachment in an e-mail  
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STEP 7: More than one file can be attached in the same email by repeating the above steps  

 

Figure 75: Add two attachments  

 

How to remove a file: 

STEP 1: Click on the ‘X’ icon next to the attached file in order to remove it from the attachments 

 

Figure 76: Remove an attachment   
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How to download an attachment from an e-mail 

When downloading an attachment, a user should be cautious. Emails coming from untrusted and 

unknown sources should not be opened as there is a high risk of containing malicious software. Although 

a lot of effort is being made by the companies offering email services to find these emails and block them, 

there is always the chance of them making their way to our inbox. If such an email is received, the user 

should first perform an antivirus scan before opening it or if the user is sure that this is a malicious file to 

delete the email immediately with the attachment. 

STEP 1: Locate and open the email with an attachment in the inbox 

 

Figure 77: Download an attachment  

STEP 2: Locate the attachment at the bottom part of the e-mail  

   

 

 

 

 

 

 

 

 

Figure 78: Download an attachment 
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STEP 3: Move the mouse cursor over the attachment. A down arrow (download) icon appears. Click on 

the download button in order to download the file 

 

 

Figure 79: Download an attachment 

STEP 4: The file will automatically be downloaded to your ‘Downloads’ folder  

 

 

 

 

 

 

 

Figure 80: Download an attachment 

Lesson Plans/Activities:  

- Lesson Plan 14 
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TÓPICO 3 ARMAZENAMENTO EM PASTAS - GOOGLE DRIVE: VISÃO 
 

 

 

The main goal of this topic is to provide the main features of ‘Google Drive’ including 

Google Docs, Google Sheets, Google Slides and Google Forms. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Linked to ‘Entrepreneurial Competences’   

- Organisational Skills: Are the abilities that allows you to stay focused on different tasks, and 

use your time effectively and efficiently in order to accomplish the expected result. 

- Time Management: Is the process of organizing and planning daily tasks  

 - Problem solving skills: Help you determine the source of a problem and find an effective solution. 
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3.1. Definição 
 

Online file storage also called ‘cloud storage’ or ‘Internet storage’ is a place where a user can store 

electronic data with a third-party service such as Google Drive, Dropbox etc. It is another option to 

traditional local storage such as tape drives, portable storage etc.   

A user can also upload/modify and share documents, presentations, spreadsheets, images, audio, videos 

etc. with others.  

First of all, in order to use Google Drive, you will need a Google Account. Google Drive is a free online data 

storage service offered by Google. It allows you to keep all your work in one place in different file formats 

and access your files anywhere from any device. With a Google account, a user can sync documents, 

photos etc. from the computer, tablet or mobile devices. It offers 15GB of free storage and this amount is 

spread across the Google Drive, Gmail and Google Photos. Users can pay £1.59/month for 100GB to 

£239.99/month for 30TB. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips:  

- You can access the Google Drive from the desktop computer, mobile application (iOS and 

Android)  

Lesson Plans/Activities:  

- Lesson Plan 15 
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3.2.  Características do Google Drive e aplicações 
 

Google Drive is used to store files and sync them to the computer. A user can use Google Drive to upload 

files/documents and edit them online. Google Drive can be installed on the computer to sync files 

automatically to the cloud.  

Google Drive offers cloud-based applications (Google Docs, Sheets, Slides and Forms) that help users to 

create and share content with team enable teamwork to cooperate effectively in real-time.  

Google applications: 

1. Google Docs (Word Processing): Is an online word processor that provides users with a real-time 

collaboration to create, share with teammates or individuals.  

2. Google Sheets (Spreadsheets): Is an online spreadsheet application and enables users to create, 

edit and collaborate with others their spreadsheets  

3. Google Slides (Presentation): Is an online presentation application that allows users to create and 

format presentations and work with other people or individual   

4. Google Forms: Is an online application that allows users to create online surveys, evaluation forms 

and quizzes and share them with other people or teams.  

Google Drive’s main features:  

1. Real-time synchronization  

2. Work with iOS and Android  

3. Integrated with external applications such as QR 

Code, mind map etc.  

4. Allows to store documents up to 1.02 million 

characters, spreadsheets up to 5 million characters, 

presentations up to 100 MB and Google Sites up to 

20000,000 characters per page 

Google Drive has various buttons and menus that helps users to navigate easier and faster such as: 

1. Press C: Create a new folder or file  

2. Press F: Use this button to take actions on the currently displayed folder 

3. Press V: Switch between displaying items as a list or a grid  

4. Press D: Expand or collapse the details pane  

5. Press T: Change the Google Drive settings or to press the Help button 

6. Press Z (when a user has selected a file or folder): Move items to a folder  

7. Press # (when a user has selected a file or folder): To move an item to Trash  

 

Lesson Plans/Activities:  

- Lesson Plan 16 
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3.3.  Log-in e navegar no Google Drive  
 

How to log-in into Google Drive 

STEP 1: Log in to your Google account* 

STEP 2: Click on ‘Sign in’ 

STEP 3: Fill in your e-mail and password 

STEP 4: Click on ‘Next’  

 

 

 

Figure 81: Log in to your Google account 

*NOTE: If you do not have a Google account, see Topic 2  

STEP 5: Click on the top right-hand side the square with dots  

STEP 6: Click on ‘Google Drive’ 
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Figure 82: Google Drive 
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How to navigate into Google Drive 

 

Figure 83: Google Drive navigation 

 

1. My Drive is the Google Drive homepage where files and folders are stored and you can only see 

your files and folders 

2. New is the button which users can create and organise files and folders  

3. Shared with me is where files and folders that others have shared with you are presented 

4. Recent is where your recently edited files and folders  

5. Starred is where you can save your ‘favorites’ files or folders that you want to access easily  

6. Trash is where you can temporarily move files you don’t need any more permanently delete 

them 

7. Help button where you can ask for help   

8. Settings button can change the settings of Google Drive such as notifications, language etc. 

9. Google Apps: Navigate through the Google Apps 

10. Profile where you can manage your profile  

11. Search box where you can type and search into the Google Drive 

 

 

 

 

 

 

1 

2 

3 
4 
5 
6 
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10 

11 
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3.4.  Organizar ficheiros e pastas     
 

How to create folders into Google Drive 

STEP 1: Click on the ‘New’ button 

STEP 2: Click on the ‘Folder’ option  

 

Figure 84: Create folders 

STEP 3: Rename the folder  

STEP 4: Click on the ‘Create’ button 

 

Figure 85: Create folders 

3 4 
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NOTE: 

Second option how to create folders  

STEP 5: Right click to the Google Drive homepage  

STEP 6: Click on the ‘New Folder’ option 

Figure 86: Create folders 

STEP 7: Rename the folder 

STEP 8: Click ‘Create’ 

Figure 87: Create folders 

 

7 
8 
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Tips:  

- Users can create folders to organise their files  

 

 

Linked to ‘Entrepreneurial Competences’   

- Organisational skills: Are abilities to help you stay focused to your goal or vision and use your 

time effectively and efficiently.  

- Problem solving skills: Help you determine the source of a problem and find an effective 

solution. 
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How to upload files or folders into Google Drive 

STEP 1: Click on the ‘New’ button 

STEP 2: Click on the ‘File upload’ option 

 

 

Figure 88: Upload files 

 

STEP 3: Select the file you want to upload into the Google Drive  

STEP 4: Click on ‘Open’  

 

 

Figure 89: Upload files 

 

3 

4 
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STEP 5: Once the file is upload on the Google Drive, you can see the file into the Google Drive homepage  

 

Figure 90: Upload files 

 

NOTE: 

On the bottom right-hand side, you can see a pop-up window which 

is a ‘Progress Window’ that let the user know when the file or folder 

is uploaded into the Google Drive. Once the file is uploaded, a green 

tick button will appear on the screen. 
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STEP 6: Click on the ‘New’ button  

STEP 7: Click on ‘Folder upload’  

 

 

Figure 91: Upload folders 

 

STEP 8: Select the file you want to upload into the Google Drive  

STEP 9: Click on ‘Open’  

 

Figure 92: Upload folders 

 

 

8 

9 



P a g e  | 80 

 

 
This project has been funded with support from the European Commission. This communication reflects the 

views only of the author, and the Commission cannot be held responsible for any use which may be made of 

the information contained therein. Submission number: 2019-1-LV01-KA204-060337 

 

STEP 10: Once the folder is uploaded on the Google Drive, you will be able to see the file into the Google 

Drive homepage  

 

Figure 93: Upload folders 

 

Lesson Plans/Activities:  

- Lesson Plan 17 
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How to manage files and folders: Rename a document/folder   

STEP 1: Log in to the Google Drive 

STEP 2: Find the file you want to rename 

STEP 4: Right click on the document 

STEP 5: Click on ‘Rename’ 

  

Figure 94: Rename documents 

STEP 6: Rename your document 

STEP 7: Click ‘OK’ 

 

STEP 6 

STEP 7 
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Figure 95: Rename documents 

 

Tips:  

- The same steps apply to rename folders    

 

How to manage files and folders: Open a file  

STEP 1: Log in to the Google Drive 

STEP 2: Find the file you want to Open  

STEP 3: Double click the file to Open 

 

 

 

 

 

 

 

 

Figure 96: Open files  

OR 

STEP 4: Find the file you want to Open 

STEP 5: Right click on the File  

STEP 6: Click on ‘Preview’  
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Figure 97: Open files 
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How to manage files and folders: Open a Folder 

STEP 1: Log in to the Google Drive 

STEP 2: Find the folder you want to Open  

STEP 3: Double click the folder to Open 

 

 

Figure 98: Open folders 

 

How to manage files and folders: Move a Document or Folder into Folders  

STEP 1: Log in to the Google Drive 

STEP 2: Find the document you want to Move  

STEP 3: Right click on the document  

STEP 4: Click on ‘Move to’ 

 

Figure 99: Move documents 
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STEP 5: Select the folder you want to move the document  

 

Figure 100: Move documents 

 

Tips:  

- The same steps apply to move folders into folders    

 

Lesson Plans/Activities:  

- Lesson Plan 18 

 

How to manage files and folders: Share a file or folder 

STEP 1: Log in to the Google Drive 

STEP 2: Find the document you want to Share  

STEP 3: Right click on the document  

STEP 4: Click ‘Share’ 
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Figure 101: Share documents 

STEP 5: Add people (e-mails) or groups to share the document  

 

 

 



P a g e  | 87 

 

 
This project has been funded with support from the European Commission. This communication reflects the 

views only of the author, and the Commission cannot be held responsible for any use which may be made of 

the information contained therein. Submission number: 2019-1-LV01-KA204-060337 

 

Figure 102: Share documents 

 

STEP 6: Select if the person will be a ‘Viewer’, ‘Commenter’ or ‘Editor’  

 

Figure 103: Share documents (Viewer, Commenter, Editor) 
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Definition: 

- Viewer: The user who can view documents and files, download documents or files and make a copy 

of documents or files 

- Commenter: The user who can comment on documents, view documents or files, download documents 

or files and make a copy of documents or files  

- Editor: The user who has the editor rights can edit Google Documents, Spreadsheets, Presentations etc. 

or folders, invite or remove other collaborators, download documents or files, make a copy of documents 

or files, upload and delete other files or folders, add and remove items from a folder.  

STEP 7: Click on ‘Send’ 

  

Figure 104: Share documents (Viewer, Commenter, Editor) 

OR 

 

STEP 1: Log in to the Google Drive 

STEP 2: Find the document you want to Share  

STEP 3: Right click on the document  

STEP 4: Click on ‘Share’ 
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Figure 105: Share documents 

 

STEP 4: Share the link with the people or groups you want to share the document 

STEP 5: Click on ‘Change to anyone with the link’ 

 

 

Figure 106: Share documents 

 

STEP 7: Select if the person will be a ‘Viewer’, ‘Commenter’ or ‘Editor’ 
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Figure 107: Share documents 

 

STEP 8: Click on ‘Copy link’. Once you click on ‘Copy link’ you can send it to anyone you want to be a 

‘Viewer, Editor or Commenter’ 

 

Figure 108: Share documents 
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STEP 9: Click on ‘Done’ 

 

Figure 109: Share documents 

Tips:  

- The same steps apply to share folders  

 

Lesson Plans/Activities:  

- Lesson Plan 19 
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How to manage files and folders: Download documents/folders 

STEP 1: Log in to the Google Drive 

STEP 2: Find the document you want to download 

STEP 3: Right click on the document 

STEP 4: Click on ‘Download’  

 

Figure 110: Download documents 

STEP 1: Log in to the Google Drive 

STEP 2: Find the folder you want to download 

STEP 3: Right click on the folder 

STEP 4: Click on ‘Download’  
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Figure 111: Download folders 

 

Tips:  

- Users can find their downloaded documents and folders locally to their computer into the 

‘Downloads’ folder 
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How to manage files and folders: Add files or folders to Starred (favourites)  

STEP 1: Log in to the Google Drive 

STEP 2: Find the document you want to mark as a Starred (favourites)  

STEP 3: Right click on the document  

STEP 4: Click on ‘Add to Starred’  

 

 

 

Figure 112: Add to starred (favorites) 

STEP 5: Click on ‘Starred’ folder (left-hand side) and you will see the documents mark as starred  

 

Figure 113: Add to starred (favorites) 
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How to manage files and folders: Remove files or folders from Starred (favourites)  

STEP 1: Log in to the Google Drive 

STEP 2: Click on ‘Starred’ folder  

  

Figure 114: Remove from starred (favorites)  

 

STEP 3: Right click on the document  

STEP 4: Click on ‘Remove from Starred’   

 

 

Figure 115: Remove from starred (favorites)  

 

Lesson Plans/Activities:  

- Lesson Plan 20 
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How to manage files and folders: Make a copy (documents)  

STEP 1: Log in to the Google Drive 

STEP 2: Find the document you want to duplicate 

STEP 3: Right click on the document  

STEP 4: Click on ‘Make a copy’   

 

Figure 116: Remove from starred (favorites) 

STEP 5: This is the copied document. Google Drive renames the document automatically into the ‘Copy 

of….’  

 

Figure 117: Make a copy (document) 
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How to manage files and folders: Remove a document/folder   

STEP 1: Log in to the Google Drive 

STEP 2: Find the document you want to remove 

STEP 3: Right click on the document  

STEP 4: Click on ‘Remove’ 

 

 

Figure 118: Remove a document 

STEP 5: To remove folders, right click into the folder you want to remove  

STEP 6: Right click on the folder 

STEP 7: Click on ‘Remove’  
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Figure 119: Remove a folder 

How to manage files and folders: Change colour to folders    

STEP 1: Log in to the Google Drive 

STEP 2: Find the folder you want to change the colour 

STEP 3: Right click on the folder 

STEP 4: Click on ‘Change colour’  

  

Figure 120: Change folders’ colour  
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STEP 5: You can choose the colour you prefer  

 

Figure 121: Change folders’ colour 

 

 

Lesson Plans/Activities:  

- Lesson Plan 21 
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3.5. Google Docs (Processamento WORD) Introdução 
 

Google Docs (Word Processing): Is an online word processor that provides a user with a real-time 

collaboration to create, share with teammates or individuals. A user can also upload/modify and share 

documents, presentations, spreadsheets, images, audio, videos etc. with others.  

 

 

 

 

 

 

 

 

 

Google Docs works like Microsoft Word and the figure below shows how they work together. Microsoft 

Word is the most common Word processing application but Google Docs offers more benefits to users. 

 

 

The main advantages of Google Docs are: 

1. Collaboration and real time synchronization: Users can work together on the same document. 

Its time saving and you avoid misunderstanding in communication. 
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2. History tracking: Users can track document changes automatically and restore the document to 

previous versions.  

3. Track changes: Users can easily provide feedback or comments to others. 

4. Auto saving: The documents are automatically saved in the Google Drive 

5. Work from anywhere: Users can open their documents/folders from anywhere and work on their 

phones/tablets/computers etc. remotely. 

 

 

Tips:  

- All you need for Google Docs is a Google account (*NOTE: If you do not have a Google Account, 

See Topic 2) 

- You can download the application of ‘Google Docs’ from any Android or iOS phone/tablet.  

 

 

 

Lesson Plans/Activities:  

- Lesson Plan 22 
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3.6. Google Docs (Processamento WORD) características 
 

How to start with Google Docs (Word Processing):  

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

 

Figure 122: Google Docs  

 

Figure 122 illustrates the home page of Google Docs. Google Docs offers users the opportunity to create 

their own blank document or any pre-sized template such as Resume, Letter, Project Proposal, Brochure, 

Report etc.  

For more templates users need to click on ‘Templates Gallery’ (Figure 123).  

Under the options of blank document and templates, users can see the recent documents created in 

Google Docs.  

 

 

Tips:  

- Users can use the Resume template to develop their CV/Resume.  
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Figure 122: Google Docs Home Page 

 

 

Figure 123: Google Docs – Templates Gallery 

 

 

Blank Document  Templates 

Recent documents 

Templates Gallery 
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How to use a blank Google document:  

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on ‘Blank’ 

 

 

 

 

Figure 124: Google Docs – Blank Document 

 

 

STEP 3 
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How to edit blank documents: Rename a Google document 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on ‘Blank’ 

STEP 4: Firstly, you need to rename your document to keep your files organized. Click on ‘Untitled 

document’ and give an appropriate name for your document 

 

Figure 125: Google Docs – Rename a document 

 

Lesson Plans/Activities:  

- Lesson Plan 23 

 

How to edit blank documents: Starred a Google document 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on ‘Blank’ 

STEP 4: Click into your Google document 

STEP 5: Click on the ‘Star icon’ next to the documents’ name and you can mark the document as 

favourites 
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Figure 126: Google Docs – Starred a document 

 

 

How to edit blank documents: Move a Google to a different folder   

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on ‘Blank’ 

STEP 4: Click into your Google document 

STEP 5: Next to the star icon, click into the ‘Move’ button 
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Figure 127: Google Docs – Move a document 

 

How to edit blank documents: Insert text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on ‘Blank’ 

STEP 4: Click into the blank document  

STEP 5: Start type anything you want 

 

Figure 128: Google Docs – Insert text into documents 
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How to edit blank documents: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on the document you want to edit 

STEP 4: Click on ‘File’  

 

Figure 129: Google Docs – Edit documents (File tab) 

 

NOTE:  

The ‘File’ tab contains various items that you may want to apply into a document: 

- Create new document and open a new document 

- Make a copy 

- Send the existing document as an attachment in an email 

- Download the document 

- History tracking 

- Make a copy 

- Move 

- Move to trash 

- Change language 

- Print   
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Tips:  

- The ‘File tab’ works the same as Google Docs, Google Sheets and Google Slides. 

 

How to edit blank documents: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on the document you want to edit 

STEP 4: Click on ‘Insert’  

 

 

Figure 130: Google Docs – Edit documents (Insert tab) 

 

NOTE:  

The ‘Insert’ tab contains various items that you may want to insert into a document: 

- Insert Images, Table, Drawing, Chart 

- Insert special characters and equation 

- Insert header and footer 

- Insert page numbers and breaks 

- Insert link 

- Insert comment 

- Insert table of contents  
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Lesson Plans/Activities:  

- Lesson Plan 24 

 

How to edit blank documents: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on the document you want to edit 

STEP 4: Click on ‘Format’  

 

 

Figure 131: Google Docs – Edit documents (Format tab) 

NOTE:  

The ‘Format’ tab contains various items that you may want to apply into a document: 

- Format text: Bold, Italic, Underline, Strikethrough, Superscript, Subscript  

- Format paragraphs and styles: Borders and shading, Heading styles  

- Align and indent 

- Format columns 

- Add bullets and numbering  

- Format header and footer 

- Format page numbers  

- Format tables and images 
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- Format tables and images 

Tips:  

- The ‘Format tab’ has the same items with the buttons in the ribbon (Figure 122). Users can edit 

the format of text using the ribbon. 

 

 

 

 

Figure 132: Google Docs – Edit documents (Format tab – Ribbon) 

 

 

Lesson Plans/Activities:  

- Lesson Plan 25  

 

 

How to edit blank documents: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on the document you want to edit 

STEP 4: Click on ‘Tools’  
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Figure 133: Google Docs – Edit documents (Tools tab) 

NOTE:  

The ‘Tools’ tab contains various items that you may want to apply into a document: 

 - Check spelling and grammar 

- Check the word count 

- Compare documents 

- Add citations 

- Search dictionary  

- Translate document 

- Use voice typing  

- Turn on accessibility settings 

 

How to edit blank documents: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on the document you want to edit 

STEP 4: Click on ‘Help’  

 

Figure 134: Google Docs – Edit documents (Help tab) 

NOTE:  

The ‘Help tab contains various items that you may want to apply into a document: 

- Get help for Docs 
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- Check for any updates  

- Check for keyboard shortcuts 

 

 

How to share Google Documents: 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Docs’  

STEP 3: Click on the document you want to edit 

STEP 4: Click on ‘Share’ 

 

 

 

  

Figure 135: Google Docs – Share documents 

NOTE: 

Users can share the document with people and groups by sending them an invitation email address or 

they can send them the sharable link to give them the appropriate rights, such as ‘Viewer, Editor, 

Commentor’. 

Tips:  

- ‘Share button’ works the same as Google Docs, Google Sheets and Google Slides (See Topic 2 for 

more details).   
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Lesson Plans/Activities:  

- Lesson Plan 26 

 

 

3.7. Google Sheets (Folhas de cálculo) Introdução 
 

Google Sheets (Spreadsheets): Is an online spreadsheet application that enables users to create, edit 

and collaborate with others their spreadsheets 

 

 

 

 

 

 

 

 

 

Google Sheets works as Microsoft Excel which is the most common spreadsheet application. Figure below 

illustrates how Google Sheets works with Excel.  
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Tips:  

- All you need for Google Sheets is a Google account 

- You can download the application of ‘Google Sheets’ from any Android or iOS phone/tablet.  

 

  



P a g e  | 116 

 

 
This project has been funded with support from the European Commission. This communication reflects the 

views only of the author, and the Commission cannot be held responsible for any use which may be made of 

the information contained therein. Submission number: 2019-1-LV01-KA204-060337 

 

3.8. Google Sheets (Folhas de cálculo) características 
 

How to start with Google Sheets (Spreadsheets):  

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’  

 

 

Figure 136: Google Sheets  

 

Figure 137 represents the home page of Google Sheets which offers users the opportunity to create their 

own spreadsheets or use any pre-sized templates such as to-do list, annual/monthly budget, schedule, 

calendar etc.  

For more templates users need to click on ‘Templates Gallery’ (Figure 138).  

Under the options of blank spreadsheet and templates, users can see the recent documents used by 

Google Sheets.  

 

Tips:  

- Users can create a to-do list in spreadsheet to organise themselves during the day/week/month 

or a calendar to organise meetings/appointments etc.   

 

Lesson Plans/Activities:  

- Lesson Plan 27 
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Figure 137: Google Sheets Home Page 

 

 

Figure 138: Google Sheets – Templates Gallery 

 

  

Blank 

Spreadsheet  
Templates 

Recent spreadsheets 

Templates Gallery 
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How to use a blank Google Spreadsheet:  

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’  

STEP 3: Click on ‘Blank’

 

 

Figure 139: Google Sheets – Blank Spreadsheet 

 

 

  

STEP 3 
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How to edit a blank spreadsheet: Rename a Google Spreadsheet 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’  

STEP 3: Click on ‘Blank’ 

STEP 4: Firstly, you need to rename your document to keep your files organized. Click on ‘Untitled 

document’ to rename the document 

 

Figure 140: Google Sheets – Rename a spreadsheet 

 

Tips:  

- The procedure to rename a Google Sheet is the same as Google Docs and Google Presentation  

 

 

Lesson Plans/Activities:  

- Lesson Plan 28 
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How to edit a blank spreadsheet: Starred a Google spreadsheet 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’ 

STEP 3: Click on ‘Blank’ 

STEP 4: Click into your Google spreadsheet 

STEP 5: Click on the ‘Star icon’ next to the spreadsheets’ name to add the spreadsheet to your favorites  

 

 

Figure 141: Google Sheets – Starred a spreadsheet 

 

How to edit blank a spreadsheet: Move a Google Spreadsheet to a different folder   

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’ 

STEP 3: Click into your Google spreadsheet 

STEP 4: Next to the star icon, click into the ‘Move’ button 
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Figure 142: Google Sheets – Move a spreadsheet 

 

How to edit a blank spreadsheet: Insert text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’  

STEP 3: Click on ‘New Spreadsheet’ 

STEP 4: Click into cells   

STEP 5: Start typing anything you want 

 

Figure 143: Google Sheets – Insert text into a spreadsheet  

NOTE: 

Users can preview the content of the cells in the formula bat (Figure 144). 

Cells 
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Figure 144: Google Sheets – Insert text into a spreadsheet  

 

 

How to edit a blank spreadsheet: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’ 

STEP 3: Click on ‘New Spreadsheet’ 

STEP 4: Click on ‘File’  

 

  

Figure 144: Google Sheets – Edit spreadsheets (File tab) 

NOTE:  

The ‘File’ tab contains various items that you may want to apply into a document: 

- Create a new spreadsheet or open a new spreadsheet 

- Make a copy 

- Email the existing spreadsheet as an attachment 
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- Download the spreadsheet 

- History tracking 

- Move to trash 

- Change language 

- Print   

 

Tips:  

- The ‘File tab’ works the same as Google Docs, Google Sheets and Google Slides  
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How to edit a blank spreadsheet: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’ 

STEP 3: Click on ‘New Spreadsheet’ 

STEP 4: Click on ‘Insert’ 

 

 

 

Figure 145: Google Sheets – Edit spreadsheets (Insert tab) 

 

NOTE:  

The ‘Insert’ tab contains various items that you may want to apply into a document - Insert rows above 

and below 

- Insert columns left and right 

- Insert cells and shift down and right 

- Insert chart, image, drawing,  

- Insert function 

- Insert link 

- Insert comment 

- Insert new sheet  
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Lesson Plans/Activities:  

- Lesson Plan 29 

 

How to edit a blank spreadsheet: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’ 

STEP 3: Click on ‘New Spreadsheet’ 

STEP 4: Click on ‘Format’ 

 

 

Figure 146: Google Sheets – Edit spreadsheets (Format tab) 

NOTE:  

The ‘Format tab contains various items that you may want to apply into a document: 

- Format number 

- Format text: Bold, Italic, Underline, Strikethrough, Font Size 

- Align  

- Text wrapping  

- Text rotation  

- Alternating colours 
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Tips:  

- The format tab has the same items with the buttons in the ribbon (Figure 137). Users can edit the 

format of text using the ribbon. 

 

 

 

 

Figure 147: Google Sheets – Edit spreadsheets (Format tab – Ribbon) 

 

How to edit a blank spreadsheet: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’ 

STEP 3: Click on ‘New Spreadsheet’ 

STEP 4: Click on ‘Data’ 

 

Figure 148: Google Sheets – Edit spreadsheets (Data tab) 

NOTE:  

The ‘Data’ tab contains various items that you may want to apply into a document: 

- Sort sheet  

- Create filter 
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- Filter views  

- Group  

 

 

 

Tips:  

- The ‘Data’ tab is only available for Google Sheets as is the only Google features where users can 

edit and format data in tables/cells/columns or rows. 

 

 

How to edit a blank spreadsheet: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’ 

STEP 3: Click on ‘New Spreadsheet’ 

STEP 4: Click on ‘Tools’ 

 

 

 

Figure 149: Google Sheets – Edit spreadsheets (Tools tab) 

NOTE:  

The ‘Tools tab contains various items that you may want to apply into a document: 

- Create a form (see next section)  

- Check spelling 

- Turn on accessibility settings 
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How to edit a blank spreadsheet: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’ 

STEP 3: Click on ‘New Spreadsheet’ 

STEP 4: Click on ‘Help’ 

 

Figure 150: Google Sheets – Edit spreadsheets (Help tab) 

NOTE:  

The ‘Help tab contains various items that you may want to apply into a document: 

- Get help for Sheets 

- Check for any updates  

- Check for keyboard shortcuts 

 

Tips:  

- The ‘Help’ tab works the same as all the Google Features (Google Docs/Sheets/Slides). 

 

 

Lesson Plans/Activities:  

- Lesson Plan 30  
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How to share Google Sheets: 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sheets’ 

STEP 3: Click on ‘New Spreadsheet’ 

STEP 4: Click on ‘Share’ 

  

Figure 151: Google Sheets – Share spreadsheets  

NOTE: 

Users can share the spreadsheet with people and groups by sending them an invitation email address or 

they can send them a sharable link to give them the appropriate rights, such as ‘Viewer, Editor, 

Commentor’. 

 

Tips:  

-  ‘Share button’ works the same as Google Docs, Google Sheets and Google Slides (See Topic 2 for 

more details).   

 

Lesson Plans/Activities:  

- Lesson Plan 31 
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3.9. Google Slides (Apresentações) Introdução  
 

Google Slides (Presentation): Is an online presentation application that allows to users create and 

format presentations and work with other people or individual   

 

 

 

 

 

 

 

 

Google Slides works as Microsoft PowerPoint which is the most common PowerPoint slides application. 

Figure below illustrates how Google Slides works with PowerPoint.  

 

 

Tips:  

- All you need for Google Slides is a Google account 

- You can download the application of ‘Google Slides’ from any Android or iOS phone/tablet.  
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3.10. Google Slides (Presentations) features  
 

How to start with Google Slides (Presentations):  

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’  

 

 

Figure 152: Google Slides  

 

Figure 153 shows the home page of Google Slides which offers users the opportunity to create their own 

presentations or use any pre-sized templates such as portfolio, recipe showcase, certificates, lesson plans, 

book reports etc.   

For more templates users can click on ‘Templates Gallery’ (Figure 154).  

Under the options of blank spreadsheet and templates, users can see the recent documents used by 

Google Slides.  

 

Tips:  

- Users can use the Google Slides to create professional presentations for meetings    

 

 

Lesson Plans/Activities:  

- Lesson Plan 32 
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Figure 153: Google Slides Home Page 

 

 

Figure 154: Google Slides – Templates Gallery 

Blank 

Spreadsheet  
Templates 

Recent spreadsheets 

Templates Gallery 
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How to use a blank Google presentation:  

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’  

STEP 3: Click on ‘Blank’ 

 

 

 

Figure 155: Google Slides – Blank Presentation 

 

 

 

 

 

STEP 3 
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How to edit a blank presentation: Rename a Google presentation  

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’  

STEP 3: Click on ‘Blank’ 

STEP 4: Firstly, you need to rename your document to keep your files organized. Click on ‘Untitled 

document’ to rename the document 

 

Figure 156: Google Slides – Rename a presentation 

 

Tips:  

- The procedure to rename a Google Presentation is the same as Google Docs and Google Sheets 

 

 

Lesson Plans/Activities:  

- Lesson Plan 33 
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How to edit a blank presentation: Starred a Google Presentation 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’ 

STEP 3: Click on ‘Blank’ 

STEP 4: Click into your Google presentation 

STEP 5: Click on the ‘Star icon’ next to the presentations’ name to add your presentation to your 

favorites 

 

 

Figure 157: Google Slides – Starred a presentation 

 

 

How to edit blank a presentation: Move a Google presentation to a different folder   

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’ 

STEP 3: Click into your Google presentation 

STEP 4: Next to the star icon, click into the ‘Move’ button 
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Figure 158: Google Slides – Move a presentation 

 

How to edit a blank presentation: Edit a presentation  

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’  

STEP 3: Click on ‘New Blank Presentation’ 

STEP 4: On the right-hand side users can view and select the different themes to your presentation  

 

Figure 159: Google Slides – Edit themes  
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Tips:  

- Users can change the theme of the presentation based on the presentation topic. Themes make 

the presentations looks creative and professional. 

OR 

STEP 5: Users can import themes  

STEP 6: Click on ‘Import’ 

STEP 7: Choose your theme 

 

 

 

Figure 160: Google Slides – Import themes  
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Lesson Plans/Activities:  

- Lesson Plan 34 

 

 

How to edit blank a spreadsheet: Edit Slides  

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’ 

STEP 3: Click on ‘New Blank Presentation’ 

STEP 4: On the left-hand side users can view and edit the slides  

 

  

Figure 161: Google Slides – Edit slides 

 

STEP 5: Click on ‘Insert’  
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Figure 162: Google Slides – Insert images/audio/video etc.  

NOTE:  

Users can add to the slides: 

- Text 

- Images 

- Tables 

- Charts 

- Diagrams 

- Shapes 

- Audio 

- Video 

 

Tips:  

- Users can use images or charts etc. to create professional and interactive presentations  

 

Lesson Plans/Activities:  

- Lesson Plan 35 & 36 & 37 
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STEP 6: Click on ‘Slide’  

 

Figure 163: Google Slides – Add New Slides/Duplicate/Delete 

NOTE:  

Users can: 

- Add a new slide 

- Duplicate a slide 

- Delete a slide 

 

STEP 5: Click on ‘Apply Layout’  
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Figure 164: Google Slides – Apply Layout 

 

NOTE:  

Users can apply the following changes on each slide:  

- Title slide 

- Section header 

- Title and body 

- Title and two columns 

- Title only 

- One column text 

- etc. 

 

Tips:  

- Users can change the layout of each slide according to the content of each slide. For example, the 

first slide could have the layout of a ‘Title Slide’ for adding a general title and a subtitle to the 

presentation, the second slide could have the layout of a ‘Title and body’ for adding text/images/videos 

etc. according to the presentation’s topic. 

 

STEP 6: Click on ‘Change background’  
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Figure 165: Google Slides – Change background 

 

 

NOTE:  

Users can change the background of each slide to a solid colour or choose an image.  

Tips:  

- Users can change the background of each slide and use their creativity to design a slide 

 

STEP 7: Click on ‘Transition’ 
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Figure 166: Google Slides – Slide Transitions  

 

NOTE:  

Users can apply a transition to one or all slides.  
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Figure 167: Google Slides – Slide Transitions 

STEP 8: Select the Title of the presentation 

 

Figure 168: Google Slides – Objects Transitions 

NOTE:  

Users can change the transition of each object.   

Tips:  

- Users always need to select the slides and objects they want to add transitions  

- Users can select and apply transitions either for slides or objects accordingly  

- For more info about the transitions 

https://www.youtube.com/watch?v=H2zAx21LxOY&ab_channel=GCFLearnFree.org  

https://www.youtube.com/watch?v=H2zAx21LxOY&ab_channel=GCFLearnFree.org
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Lesson Plans/Activities:  

- Lesson Plan 38 

 

How to edit a blank presentation: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’ 

STEP 3: Click on ‘New Blank Presentation’ 

STEP 4: Click on ‘File’  

 

Figure 169: Google Slides – Edit presentations (File tab) 

 

NOTE:  

The ‘File’ tab contains various items that you may want to apply into a document:  

- Create and open a new presentation 

- Import slides 

- Make a copy 

- Email the existing spreadsheet as an attachment 
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- Download the presentation 

- History tracking 

- Make a copy 

- Move to trash 

- Change language 

- Print   

 

Tips:  

- The ‘File tab’ works the same as Google Docs, Google Sheets and Google Slides. 

 

How to edit blank a presentation: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’ 

STEP 3: Click on ‘New Blank Presentation’ 

STEP 4: Click on ‘Format’ 

 

 

Figure 170: Google Slides – Edit text 
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NOTE:  

The ‘Format tab contains various items that you may want to apply into a document: - Format text: Bold, 

Italic, Underline, Strikethrough, Font Size 

- Align and indent  

- Line spacing  

- Bullets and Numbering   

- Borders and lines 

  

Tips:  

- The format tab has the same items with the buttons in the ribbon (Figure 171). Users can edit the 

format of text using the ribbon. 

 

 

 

 

Figure 171: Google Slides – Edit text (Format tab – Ribbon) 

 

How to edit blank a presentation: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’ 

STEP 3: Click on ‘New Blank Presentation 

STEP 4: Click on ‘Tools’ 
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Figure 172: Google Slides – Edit Presentations (Tools tab) 

 

NOTE:  

The ‘Tools tab’ contains various items that you may want to apply into a document: 

- Create form (see next section)  

- Check spelling 

- Turn on accessibility settings 

 

Tips:  

- The ‘Tools Tab’ works the same as Google Sheets and Google Slides.  

 

How to edit blank presentations: Edit text 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’ 

STEP 3: Click on ‘New Blank Presentation’ 

STEP 4: Click on ‘Help’ 



P a g e  | 149 

 

 
This project has been funded with support from the European Commission. This communication reflects the 

views only of the author, and the Commission cannot be held responsible for any use which may be made of 

the information contained therein. Submission number: 2019-1-LV01-KA204-060337 

 

Figure 173: Google Slides – Edit presentations (Help tab) 

NOTE:  

The ‘Help tab’ contains various items that you may want to apply into a document: 

- Get help for Slides 

- Check for any updates  

- Check for keyboard shortcuts 

 

Tips:  

- The ‘Help’ tab works the same for all the Google Features (Google Docs/Sheets/Slides). 

 

How to share Google Slides: 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’ 

STEP 3: Click on ‘New Blank Presentation’ 

STEP 4: Click on ‘Share’ 
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Figure 174: Google Slides – Share presentations  

NOTE: 

Users can share the presentation with people and groups by sending them an invitation email or by 

sending them a sharable link to give them the appropriate rights, such as ‘Viewer, Editor, Commentor’. 

Tips:  

-  ‘Share button’ works the same as Google Docs, Google Sheets and Google Slides (See Topic 2 for 

more details).   
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How to edit blank a presentation: Add speaker notes 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’ 

STEP 3: Click on ‘New Blank Presentation’ 

STEP 4: Click below the slide ‘Click to add speaker notes’ 

 

 

Figure 175: Google Slides – Add speaker notes  

NOTE:  

Speaker notes: Adding speaker notes to a PowerPoint presentation provides reference material for the 

speaker when they’re presenting a slideshow. Speaker notes are available only on your presentation and 

printed version, are not available to the audience.  

 

Tips:  

- The ‘Speaker Notes’ are only available to Google Slides.  

- Users can use the speaker notes to add some notes to each slide while they presenting to stay on 

track without forgetting key message points. 
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How to edit a blank presentation: Present  

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Slides’ 

STEP 3: Click on ‘New Blank Presentation’ 

STEP 4: Click on ‘Present’ 

 

 

Figure 176: Google Slides – Present  

 

 

Lesson Plans/Activities:  

- Lesson Plan 39 
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3.11. Google Forms Introdução 
 

Google Forms: Is an online application that allows users to create online surveys, evaluation forms and 

quizzes and share them with other people or teams. 

 

 

 

 

 

 

 

 

Google Forms advantages:   

1. Create unlimited free forms with Google 

templates  

2. Integrate several types of questions: Text, 

Multiple choice questions, Date, True/False etc. 

3. Edit the header colour or image, background 

colour, logos etc. and import images or videos. 

4. Add collaborators and share the form with 

other people/team  

5. Preview the survey/evaluation/questionnaire 

will look before sending it over to the recipients 

6. Sending options such as Email, embed link or embed HTML 

7. Integrate Google Sheets and can access to a spreadsheet view of the collected data  

 

 

 

 

Tips:  

- All you need for Google Forms is a Google account 
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3.12. Google Forms características 
 

 

How to start with Google Forms:  

STEP 1: Log in to your Google account 

STEP 2: Click on Google Search 

STEP 3: Type ‘Google Forms’ 

 

 

 

Figure 177: Google Forms   

 

STEP 4: Click on the first option appears in the results list   
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Figure 178: Google Forms   

Here is the Google Forms website. 

 

 

Figure 179: Google Forms Website 
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How to start with Google Forms:  

STEP 1: Log in to your Google account 

STEP 2: Click on Google Search 

STEP 3: Find the ‘Google Forms’ website 

STEP 4: Click on ‘Go to Google Forms’ 

 

 

 

Figure 180: Google Forms Home page 

Here is the Google Forms home page. 
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Figure 181 shows the home page of Google Forms. Google Forms offers users the opportunity to create 

their surveys/questionnaires/evaluation forms and it works similarly to Survey Monkey. Additionally, 

Google Forms offers the opportunity to use templates and users can edit the templates based on their 

preferences or users can create a blank form to start from scratch a survey/evaluation/questionnaire etc.   

Figure 182 shows the homepage of Google Forms where user can choose a ‘Blank Form’ or choose any 

template. For more templates users need to click on ‘Templates Gallery’ (Figure 172), such as templates 

about event registration, party invite, order form, event feedback, customer feedback etc.  

Under the options of blank document and templates, users can see the recent documents created with 

Google Forms.  

 

 

Figure 181: Google Forms Home Page 

 

Figure 182: Google Forms – Templates Gallery 

 

Blank Form  Templates 

Recent forms 

Templates Gallery 
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Lesson Plans/Activities:  

- Lesson Plan 40 

 

How to use a blank Google Form:  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on ‘Blank’ 

 

 

 

 

Figure 183: Google Forms – Blank Form 

 

STEP 3 
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How to edit blank forms: Rename a Google Form 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on ‘Blank’ 

STEP 4: Firstly, you need to rename your document to keep your files organized. Click on ‘Untitled Form’ 

to rename your form 

 

Figure 184: Google Forms – Rename a Form 

 

 

Lesson Plans/Activities:  

- Lesson Plan 41 

 

How to edit a blank Form: Starred a Google Form 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 5: Click on the ‘Star icon’ next to the form’s name to can add your Form to your favourites 
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Figure 185: Google Forms – Starred a Form 
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How to edit a blank form: Move a Google Form to a different folder   

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 4: Next to the star icon, click on the ‘Move’ button 

 

Figure 186: Google Forms – Move a Form 

How to edit a blank form: Make a copy of the Google Form 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 4: Click on the ‘Three dots button’ at the top right-hand side 

STEP 5: Click on ‘Make a copy’  

 

Figure 187: Google Forms – Make a copy 
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How to edit a blank form: Move to trash (Delete) 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 4: On the ‘Three dots button’ at the top right-hand side click  

STEP 5: Click on ‘Move to trash’  

 

Figure 189: Google Forms – Move to trash (Delete) 

How to edit a blank form: Print 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 4: On the ‘Three dots button’ at the top right-hand side click 
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STEP 5: Click on ‘Print’   

Figure 190: Google Forms – Print 

 

How to edit a blank form: Add collaborators  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 4: On the ‘Three dots button’ at the top right-hand side click 

STEP 5: Click on ‘Add collaborators’   
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Figure 191: Google Forms – Add Collaborators  

 

Tips:  

-  ‘Add collaborators button’ works the same as Google Docs, Google Sheets and Google Slides (See 

Topic 2 for more details).   

 

 

Lesson Plans/Activities:  

- Lesson Plan 42 

 

 

 

How to edit blank form: Customize theme  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 4: Click on ‘Customize theme’ button at the top navigation 
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Figure 192: Google Forms – Customize theme 

NOTE: 

Users can customize the theme: 

- Customize header: Upload an image as a header  

- Change the theme colour  

- Change the background colour 

- Change the font style 

Figure 193: Google Forms – Customize theme 

 

For example: 
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Figure 194: Google Forms – Customize theme (Example) 

 

 

Lesson Plans/Activities:  

- Lesson Plan 43 

 

How to edit a blank form: Preview the Google form  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 4: Click on ‘Preview’ button at the top navigation bar  

 

Figure 185: Google Forms – Preview the Google form 

 



P a g e  | 167 

 

 
This project has been funded with support from the European Commission. This communication reflects the 

views only of the author, and the Commission cannot be held responsible for any use which may be made of 

the information contained therein. Submission number: 2019-1-LV01-KA204-060337 

 

NOTE: 

Users can preview the Google form before to share it with recipients. 

 

How to edit a blank form: Send the Google form  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 4: Click on ‘Send’ button at the top right-hand side 

 

 

Figure 196: Google Forms – Send the Google Form 

NOTE: 

Users can send the form via Email, as a link or embed HTML 
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Figure 197: Google Forms – Send the Google Form 

Tips:  

- Mostly, users prefer to send the Google Form with a sharable link as is easier and faster. Figure 

185 shows how the users can send the Google form via a link.  

- Also, users can make ‘shorten URL link’ of the Google form link (Figure 185). 

 

 

  

Figure 198: Google Forms – Send the Google Form  

 

 

E-mail 

Link 

Embed HTML 

Shorten URL 
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How to edit a blank form: Edit and Add Form title and Form description 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 4: Click on the ‘Form Title’ and ‘Form Description’  

 

Figure 199: Google Forms – Edit Form Title and Form Description  

 

Tips:  

- Users can change the Form Title and Description to keep their Google Forms organized and also to 

let the recipients clearly see the purpose of the survey. 

 

STEP 5: Users can add more than one title and description. Click on the right hand side ‘Title and 

Description’   
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Figure 200: Google Forms – Add Form Title and Form Description  

 

How to edit blank form: Add and edit images and videos 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit   

STEP 4: Click on ‘Add Image’ at the right hand side  

 

Figure 201: Google Forms – Add image  

 

STEP 5: Choose an image from your local computer or Google Drive or Google search for any photos 
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Figure 202: Google Forms – Insert image 

 

STEP 6: Click on the image using the blue circles around the image to minimize or maximize the image. 

(Figure 190)  

 

Insert image 

STEP 6 
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Figure 203: Google Forms – Edit an image 

STEP 7: Click on the ‘three dots’ at the left hand size of the image  

 

Figure 204: Google Forms – Edit an image 

NOTE: 

Users can edit the image: 

- Align the image: Left, Center, Right 

- Change the image 

- Remove the image (Delete) 

 

 

 

STEP 6 
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Figure 205: Google Forms – Edit an image (Align, Change, Delete) 

 

STEP 8: Click on ‘Add Video’ at the right-hand side 

 

 

Figure 206: Google Forms – Add Video 

STEP 9: Choose a video from YouTube channel or provide the URL link 
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Figure 207: Google Forms – Add Video 

Here is the video in the Google Form. 

 

Figure 208: Google Forms – Add Video 

Tips:  

- Users can edit video following the same procedure as images (see steps 6-7).  

 

Lesson Plans/Activities:  

- Lesson Plan 44 

 

Insert video 
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How to edit a blank form: Add and edit questions 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit  

STEP 4: Click on ‘Add question’ button at the right-hand side 

 

 

Figure 209: Google Forms – Add question 

 

STEP 5: Click on the top of the question box to insert a question title 

 

 

 

 

The added 

question 
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Figure 210: Google Forms – Edit question title 

 

STEP 6: Users can add image into the question to be more attractive. Click on the image icon next to the 

question title 

 

Figure 211: Google Forms – Edit questions (Add image) 

Tips:  

- Users can edit the photo in each question using the same procedure (see above) 

 

STEP 7: Users can add image into the question to be more attractive. Click on the image icon next to the 

question title 

 

STEP 5: 

Question 

title 
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Figure 212: Google Forms – Question Types 

NOTE: 

Question types: 

Question Type Figure 

Short answer: Users 
can provide answers in 
a few sentences 

 

Paragraph: Users can 
provide answers in a 
paragraph 

 

Question 

Types 
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Multiple Choice: Users 
can choose an answer 
from a set of options ; 
one answer is the 
correct and there is 
also the ‘Other’ option 
where users can 
provide a short answer 

 
Checkboxes: Users can 
choose an answer 
among a set of options; 
more than one answer 
is the correct. There is 
also the ‘Other’ option 
where users can 
provide a short answer 

 
Dropdown: Users can 
choose an answer 
among the options 
given in a dropdown 
list; one answer is the 
correct  
 

 
File upload: Users can 
upload files as a 
response to a question  
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Linear scale: Users can 
choose an answer on a 
scale, starts at 0 or 1 
and ends to 10 

 
Multiple choice grid: 
Users can select one 
answer per row  

 
Checkbox grid: Users 
can choose more than 
one answer per row  
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Date: Users can add 
questions regarding 
the date  

 
Time: Users can add 
questions regarding 
the time or duration 

 
 

 

Lesson Plans/Activities:  

- Lesson Plan 45 

 

How to edit a blank form: Duplicate/Delete/Required  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to edit  

STEP 4: Click on ‘Duplicate’ to duplicate the question which is selected 

 

 

Figure 213: Google Forms – Duplicate question 

STEP 5: Click on ‘Delete’ to delete the question which is selected 
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Figure 214: Google Forms – Delete question 

STEP 6: Click on ‘Required’ to set the specific question as a require question in the form  

 

 

Figure 215: Google Forms – Required question 

 

Tips:  

- Users can set questions as required which means that respondents should provide an answer. 

 

 

NOTE: 

- The ‘Star icon’ is used for recipients to recognize the ‘Required’ questions  
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Figure 216: Google Forms – Required question 

 

 

 

Lesson Plans/Activities:  

- Lesson Plan 46 
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How to edit a blank form: Add section 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on a form you want to edit  

STEP 4: Click on ‘Add section’ at the right-hand side 

 

Figure 217: Google Forms – Add section 

Tips:  

- Users can add sections to divide and organize different topics into the Google Form  

 

 

STEP 4: Click on ‘Untitled Section’ to add a section title and description which are optional 

 

Figure 218: Google Forms – Add section (Title and Description) 
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For example: 

 

Figure 219: Google Forms – Section example 

 

NOTE: 

Users can move into the ‘Next section’ by clicking on the ‘Next button’ 

 

 

Figure 220: Google Forms – Section example 

How to view responses:  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to view   

STEP 4: Click on ‘Responses’ at the top menu of Google Form 

NOTE: 

Users are able to see the number of responses of each Google Form 
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Figure 221: Google Forms – View responses 

 

 

 

 

 

 

 

 

Number of 

responses 
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NOTE: 

Users are able to view responses: Summary, By question, Individual. In the summary page all responses 

are in the form of charts; pie chart for multiple choice questions, bar charts for linear scale grid 

questions.  

 

Figure 222: Google Forms – View responses (Summary/Question/Individual) 

 

STEP 5: Click on the icon of ‘Spreadsheet’ at the top menu of the responses page. Users are able to view 

all responses in a Spreadsheet and export them in a spreadsheet 

 

Figure 223: Google Forms – View all responses in a Spreadsheet 

STEP 6: Users are able to print and delete all responses into the Google form  

STEP 7: Click on the ‘three dots’ icon at the top menu 

STEP 8: Click on ‘Print all responses’ 

STEP 9: Click on ‘Delete all responses’ 

Summary 

By question Individual 
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Figure 224: Google Forms – Print/Delete all responses  

How to view responses: Get email notifications for new responses 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Forms  

STEP 3: Click on the form you want to view  

STEP 4: Click on the ‘three dots’ icon at the top menu  

STEP 5: Click ‘Get email notifications for new responses’  

Figure 225: Google Forms – Get email notifications for new responses   

 

Lesson Plans/Activities:  

- Lesson Plan 47 

 

STEP 8 

STEP 9 
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TÓPICO 4 CALENDÁRIO GOOGLE CALENDAR & CONTACTOS 

GOOGLE: VISÃO 
 

 

 

This topic presents all necessary information that will support adults to understand 

the main features of Google calendar and Google contacts. The main learning 

outcomes are how to create calendars, events, contacts or group of contacts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Linked to ‘Entrepreneurial Competences’   

- Organisational Skills: Are the abilities that allows you to stay focused on different tasks, and 

use your time effectively and efficiently in order to accomplish the expected result. 

- Time Management: Is the process of organizing and planning the daily tasks  

 - Problem solving skills: Help you determine the source of a problem and find an effective solution. 

- Goal setting: Is the development of an action plan created to motivate and lead a person or group 

toward the accomplishment of a goal. 
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4.1. Definição 
 

Google Calendar is a time-management and scheduling calendar created by Google. Users can quickly 

and easy schedule meetings, events, appointments etc. and get reminders about their upcoming 

activities or they can share events/meetings with other people. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Google Contacts is a contact management tool that is available under Google applications. It is a place 

where users can store and organise contact information. Each contact can include information such as 

first name, last name, email, phone number, description etc.   

 

 

 

Tips:  

- You can access the Google Calendar and Google Contacts from the desktop computer, mobile 

application (iOS and Android) 

 

  



P a g e  | 190 

 

 
This project has been funded with support from the European Commission. This communication reflects the 

views only of the author, and the Commission cannot be held responsible for any use which may be made of 

the information contained therein. Submission number: 2019-1-LV01-KA204-060337 

4.2.  Características do Calendário Google e dos Contactos Google  
 

Google Calendar advantages: 

1. Share calendar with others 

2. Set reminders for events/meetings/appointments etc.  

3. Load Public Calendars: For example, Google Calendar 

offers the Cyprus Holidays  

4. Available anywhere and anytime 

5. Sync Google calendar with Android  

 

 

 

 

 

 

Google Contacts advantages: 

1. Import and export contacts 

2. Sync contacts with Google Email (Gmail) 

3. All-important contacts are in one place  

4. Create groups to manage contacts  

5. Accessible from anywhere and anytime 

6. Users can create one or more than one calendar 

 

 

 

 

Lesson Plans/Activities:  

- Lesson Plan 48 
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4.3.  Google Calendar log-in and navigation  
 

How to log-in into Google Calendar 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sign in’ 

STEP 3: Fill in your e-mail and password 

STEP 4: Click on ‘Next’  

 

 

 

Figure 226: Log in to your Google account 

 

STEP 5: Click on the square with dots at the top right-hand side 

STEP 6: Click on ‘Google Calendar’ 
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Figure 227: Google Calendar 
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How to navigate into Google Calendar: 

 

Figure 228: Google Calendar navigation 

 

1. Calendar is the Google Calendar homepage where users can see each day/week/month 

events/appointments etc. 

2. Create is the button which users can create events/meetings/appointments etc.  

3. Calendar – Month view is where users can see the whole month and the selected date is 

indicated in the blue circle  

4. My calendars is where users can see their calendars and calendars which other people shared 

with them 

5. Month/Day/Week is the button where users can change how they view their calendar per 

day/week/month/year etc.  

 

 

 

Tips:  

- The rest of the navigation bar are the same for all the Google Applications 

 

 

 

 

1 

2 

3 

4 

5 
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How to create a new calendar:  

Tips:  

- Google Calendar offers each Google account user the opportunity to create one or more Google 

Calendars 

 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Calendar  

STEP 3: Click on ‘+’ next to ‘Other calendars’   

 

 

Figure 229: Create new calendar 

 

STEP 4: Click on ‘Create new calendar’   
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Figure 230: Create new calendar  

NOTE: 

- Users must fill in the following fields: the name of the calendar, a description and the time zone. 
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STEP 5: Click on ‘Create new calendar’   

 

Figure 231: Create new calendar 

NOTE: 

- This is the draft calendar 

 

 

Figure 232: Create new calendar 
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Lesson Plans/Activities:  

- Lesson Plan 49 

 

 

How to browse calendars of interest: 

Google Calendars of interest: Are the calendars that Google provide for free such as Orthodox 

holidays, Christian holidays, or sports team schedules. 

 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Calendar  

STEP 3: Click on ‘+’ next to the ‘Other calendars’ 

STEP 4: Click on ‘Browse calendars of interest’  

 

 

Figure 233: Browse calendars of interest 

 

NOTE: 

- Users can add other public calendars into their Google account such as Christian Holidays, Orthodox 

Holidays, Sports etc. 
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Figure 234: Browse calendars of interest 
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How to select multiple calendars: 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Calendar  

STEP 3: Click on ‘’ next to each calendar at the left hand side to view one or more calendars    

 

  

Figure 235: View calendars 
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How to hide a calendar:  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Calendar  

STEP 3: Click on the three dots next to the name of each calendar at the left hand side 

STEP 4: Click on ‘Hide from list’ 

 

Figure 236: Hide calendar 

 

 

Lesson Plans/Activities:  

- Lesson Plan 50 
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How to manage settings and sharing: 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Calendar  

STEP 3: Click on the three dots next to the name of each calendar at the left hand side 

STEP 4: Click on ‘Settings and Sharing’ 

 

 

Figure 237: Manage settings and sharing 
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Figure 238: Manage settings and sharing 

 

NOTE: 

- Users can change the calendar settings: Calendar name, description and time zone. 

- Users can get access permissions either to make the calendar available to public either to get a 

shareable link 

- Users can share a calendar with specific people and give different permissions, for example to see all 

event details, make changes to events, make changes and manage sharing 
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Figure 239: Manage settings and sharing 
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How to remove a calendar:  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Calendar  

STEP 3: Click on the three dots next to the name of each calendar at the left-hand side  

STEP 4: Click on ‘Manage settings and sharing’ 

STEP 5: Click on ‘Delete’ 

 

 

Figure 240: Remove a calendar 
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How to edit calendar colour:   

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Calendar  

STEP 3: Click on the three dots next to the name of each calendar at the left-hand side 

STEP 4: Change the colour 

 

 

Figure 241: Change the calendar colour 

 

 

Lesson Plans/Activities:  

- Lesson Plan 51 
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4.4. Editar um calendário 
 

How to create events: 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Calendar  

STEP 3: Choose the view you prefer to look (Day/Weekly/Monthly) 

STEP 4: Choose a date   

STEP 5: Click on ‘Create’ at the top left-hand side 

 

 

Figure 242: Create events  

STEP 6: Click on ‘More options’ 
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Figure 243: Create events  

NOTE: 

Users can change: 

- The title/name of the event  

- Date and time  

- The duration of the event  

- The frequency of the event 

- Location  

- Notifications  

- Add guests 

- Add description 
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Figure 245: Create events  
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How to view and edit events: 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Calendar  

STEP 3: Choose the view you prefer to look (Day/Weekly/Monthly) 

Here is the event: 

 

Figure 246: View events  

STEP 4: Click on the event  

 

Figure 247: View events  
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NOTE: 

Users can edit events: 

- Edit event name, description, time etc. 

- Delete the event  

- Send an email to guests 

- Duplicate to other calendars   

 

 

Lesson Plans/Activities:  

- Lesson Plan 52 
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4.5.  Log-in e navegar nos Contactos Google  
 

How to log-in into Google Contacts 

STEP 1: Log in to your Google account 

STEP 2: Click on ‘Sign in’ 

STEP 3: Fill in your e-mail and password 

STEP 4: Click on ‘Next’  

 

 

 

Figure 248: Log in to your Google account 

 

STEP 5: Click the square with dots at the top right-hand side 

STEP 6: Click on ‘Google Contacts’ 
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Figure 249: Google Contacts 
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How to navigate into Google Contacts: 

 

Figure 250: Google Calendar navigation 

 

1. Contacts is the Google Contacts homepage where users can see their contacts 

2. Create is the button which users can create contacts  

3. Frequently contacted is the place where the most frequently used contacts are stored 

4. Create label is where users can create labels and organize their contacts  

5. Import/Export/Print is where users can import users as CSV or vCard files, export contacts as 

CSV files and print them 

6. Trash is the button users can delete the contacts  

 

 

Tips:  

- The rest of the navigation bar are the same as all the Google Applications 

 

 

 

 

  

1 

2 

3 

4 
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How to create new contacts:  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Contacts   

STEP 3: Click on ‘Create contact’ at the top left-hand side 

 

 

Figure 251: Create contacts 

STEP 4: Click on ‘Create a contact’  

 

Figure 237: Create a contact 
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Tips:  

- Users can create one or multiple contacts  

 

STEP 5: Fill in the required fields  

 

 

Figure 238: Create a contact 

 

NOTE: 

Users should fill in the required fields:  

- First name and Last name  

- Company  

- Job title  

- Email 

- Telephone (and select the country code e.g. Cyprus) 

-Notes (if needed) 
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For example: 

 

Figure 239: Create a contact 

 

Tips:  

- Once the user fill in the ‘Email’ field, the ‘Label’ field is automatically selected and users can select 

the category that a contact can be stored.  

- Users can create labels for ‘Work’ or ‘Meetings’ so they can have all their colleagues under one 

label/one place.   

STEP 6: Click on ‘Save’  

 

Figure 240: Create a contact 
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Here is the contact: 

 

 

Figure 241: Create a contact 

 

 

Lesson Plans/Activities:  

- Lesson Plan 53 

 

 

How to create label:  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Contacts   

STEP 3: Click on ‘Create label’ at the left-hand side 
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Figure 242: Create label 

 

STEP 4: Fill in the field with the name of the label 

STEP 5: Click on ‘Save’ 

 

 

Figure 243: Create label 

 

Here is an example of ‘Work’ label:  

 

STEP 4 

STEP 5 
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Figure 244: Create label 
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NOTE: 

Users can edit or delete the label (Figure 245) 

 

Figure 245: Edit or delete label  

How to move contacts into labels:  

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Contacts   

STEP 3: Click on ‘Contacts’ at the left-hand side 

STEP 4: Select one contact and click on the three dots 

STEP 5: Click on the name of the label. In figure 246 click on ‘Work’ label 

 

Figure 246: Move contacts into labels 

STEP 4 

STEP 5 



P a g e  | 221 

 

 
This project has been funded with support from the European Commission. This communication reflects the 

views only of the author, and the Commission cannot be held responsible for any use which may be made of 

the information contained therein. Submission number: 2019-1-LV01-KA204-060337 

How to make ‘Starred’ contacts (favourites): 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Contacts   

STEP 3: Click on ‘Contacts’ at the left-hand side 

STEP 4: Click on the ‘Star’ icon 

 

 

Figure 247: Starred contacts 

Here are the starred contacts: 

 

Figure 248: Starred contacts 
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How to edit contacts: 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Contacts   

STEP 3: Click on ‘Contacts’ at the left-hand side 

STEP 4: Click on the ‘Pencil’ icon 

 

 

Figure 249: Edit contacts 

How to delete contacts: 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Contacts   

STEP 3: Select one contact and click on the three dots 

STEP 4: Click on ‘Delete’  
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Figure 250: Delete contacts 

How to import and export contacts: 

STEP 1: Log in to your Google account 

STEP 2: Log in to Google Contacts   

STEP 3: Click on ‘Import’ at the left-hand side 

 

 

Figure 251: Import contacts 
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STEP 4: Select any CSV or vCard file  

STEP 5: Click on ‘Import’ 

 

 

Figure 252: Import contacts 

 

STEP 3: Click on ‘Export’ at the left-hand side panel 

 

 

Figure 253: Export contacts 
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STEP 3: Select the contact list and export file type 

STEP 4: Click on ‘Export’ 

 

 

Figure 254: Export contacts 

 

 

NOTE: 

- Users should export the contact as Google CSV, Outlook CSV and vCard  

 

 

 

Lesson Plans/Activities:  

- Lesson Plan 54 
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GLOSSÁRIO  
 

 

Online search is the process of interactively searching for and recovering requested data through the 

Internet (Hawkins, Donald, Brown & Carolyn, 1980).  

Internet: The Internet is the most significant communication network of computers and electronic devices 

in the world. The Internet has many applications, such as electronic mail (email), transfer of files, chatting 

online, and the most used application of all the World Wide Web (www).  

WWW: The World Wide Web or "WWW" or the "The Web" as it is also called is the application of the 

Internet which contains websites and web pages which can be accessed by a URL typed on a web browser. 

Web browser: A software such as Google Chrome, Mozilla Firefox and Internet Explorer that lets a 

computer to access and display documents, pictures, sound or videos from the World Wide Web. 

URL/Domain: A domain, or domain name, is the address (or URL) that people will use to visit your website 

on the internet. It appears in the address bar of the web browser. For example, 

www.emphasyscentre.com 

Top-Level Domain (TLD): A top-level domain is to identify a website, such as its purpose, the owner, or 

the geographical origin. 

Advanced search: Is a built-in feature of Google (and most web engines) that allows a user to specify 

additional requirements while searching forinformation. Figure 8 illustrates the advanced search features. 

A user can search information for a specific topic, language, region, words, file format etc. 

Browser history: Is the list of previously visited websites a user has visited—it includes information such 

as page title and time of visit — for a certain period of time. 

Email: Is a method in which a person can send information from a computer to another, using the Internet. 

That information can vary between text, image, audio, and video. Emails are ideal for international 

communication with no delay, no cost and top many recipients.  

Gmail is a free email service developed by Google and users all they need is to connect their Google 

account with the Gmail. 

Viewer: The user who can view documents and files, download documents or files and make a copy of 

documents or files 

Commenter: The user who can comment on documents, view documents or files, download documents 

or files and make a copy of documents or files  

Editor: The person user who has editor rights can edit Google Documents, Spreadsheets, Presentations 

etc. or folders, invite or remove other collaborators, download documents or files, make a copy of 

documents or files, upload and delete other files or folders, add and remove items from a folder. 
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User ID / Username is a unique identification (there cannot be two accounts with the same username) of 

a person on a particular server. 

Domain name / Host name is the location at which the mail is sent. This refers to the mail server which is 

the computer where the recipient has a mailbox. For example @gmail.com, @yahoo.com, @outlook.com  

Spam e-mail is an unwanted junk email and it can include malicious links. Often, spam e-mail is sent for 

commercial purposes such as advertisements, newsletters etc. 

Google Drive is a free online data storage service offered by Google. It allows you to keep all your work in 

one place in a different file format and access your files anywhere from any device. 

Google Docs (Word Processing) is an online word processor that provides to a user a real-time 

collaboration to create, share with teammates or individuals. A user can also upload/modify and share 

documents, presentations, spreadsheets, images, audio, videos etc. with others. 

Google Sheets (Spreadsheets) is an online spreadsheet application and enables users to create, edit and 

collaborate with others their spreadsheets 

Google Slides (Presentation) is an online presentation application that allows users to create and format 

presentations and work with other people or individual   

Google Forms is an online application that allows users to create online surveys, evaluation forms and 

quizzes and share them with other people or teams. 

Google Calendar is a time-management and scheduling calendar by Google. Users can quickly and easy 

schedule meetings, events, appointments etc. and get reminders about upcoming activities or they can 

share the events/meetings with other people, so they always know what’s next on the agenda.  

Google Contacts is a contact management tool that is available under Google applications. Is a place 

where users can store and organise their contacts. Each contact can include information such as first 

name, last name, email, phone number, description etc.   

Attachments:  Apart from simple text messages, email messages can contain image files, sound files, video 

clip files, compressed files etc. These files are known as attached files or simply as attachments. Attached 

files are files are sent together with e-mail messages. 
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